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Foreword to Version 1.1.2

Since version 1.0 in May 2010, exactly a year has gone by and we have worked to 

adapt VennMaker to the needs of our growing user community, both in academics and 

praxis, and to implement new features. Numerous small and not-so-small suggestions 

for optimizing the program were noted and turned into new, user-friendly solutions. We 

would like to thank all the users who contributed to continually improving this program.

VennMaker has been presented at a number of conferences (Nacht der Wissenschaft  

2010 (Long Night of Sciences 2010), Sunbelt 2010, 2011) and trade fairs (Didacta 2010, 

CeBIT 2010, 2011). It has also been demonstrated during workshops in Europe and the 

USA.  VennMaker  has  even  become part  of  the  curriculum of  the  annual  “Summer 

School  Social  Network  Analysis”  in  Trier.  A milestone,  however,  was  the  network 

conference  INSNA in  Riva  del  Garda  (Italy)  in  June  2010  where  VennMaker  was 

presented for the first time by colleagues who had used the software for their research 

independently from our project and without our previous knowledge. This means that 

VennMaker has learned to walk and has passed beyond the first  phase of growing 

pains, and so we are confident of future developments.

A further  highlight  was the international  conference on the  state  of  development  of  

qualitative and participative network visualization processes in autumn 2010 in Trier. In 

addition  to  other  network  programs  (e.g.  EgoNet.QF  and  Egonet)  and  interesting 

“paper-and-pencil” solutions, various VennMaker uses were presented. These ranged 

from  historical  research  and  processes  relevant  to  migration  issues  to  successful 

implementation  of  VennMaker  in  international  manager  training  and  in  the  financial  

services sector. The conference transcript is set to be published in 2011 (Schönhuth et 

al. 2011: Vom Papier zum Laptop / From Paper to Laptop. Transcript-Verlag).

In addition to optimizing usability, as mentioned above, VennMaker 1.1.2 has many new 

features,  especially  in  the  free  network  drawing  mode.  Here  some  of  the  most 

important:

1. Spring Embedder: re-positions the nodes (+ edges) on the network map based on 

objective mathematical specifications. 
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2. Actors and relations can be tagged with attributes: This allows not only actors but 

also relationships between actors to be described better both qualitatively and 

quantitatively. 

3. Interviews (+ audio files) within a project are saved and compressed in a common 

project file (“project container”). This saves disk space and facilitates data exchange 

between project members.

4. The export capabilities have been expanded. The resolution of pictures generated 

can be specified. This is especially interesting for publications where high-quality 

pictures are important.

Moreover – and we are a bit proud of this - the languages VennMaker can be used in 

have been increased: in addition to German and English, users can now communicate 

with VennMaker in Russian, Spanish and Chinese. Thus the advantages of participative 

network software for communicative validation with subjects can be used in more and 

more  languages.  Our  intermediate  goal  is  to  offer  our  software  in  all  major  UN 

languages. 

Many thanks to all co-developers and, of course, to the members of the creation team, 

who advanced the development and spread of VennMaker through inspiration, untiring 

dedication and creative thinking.  Special  thanks to  the Cluster  of  Excellence Social 

Dependencies and Social Networks at the University of Trier and of Mainz, which has 

significantly encouraged the development of VennMaker, and has ensured this support,  

which includes both the allocation of personnel resources and equipment, will continue 

in the coming years. 

Trier May 1, 2011

Michael Schönhuth
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1 VennMaker: Roots, Context and Fields of Application

In recent decades, the concept of social networks has gained wider currency among 

various academic disciplines and areas of inquiry. Social network research generally 

involves collecting data which describe patterns of  relationships and support  among 

individuals,  then  analyzing  them  by  employing  concepts  drawn  from  graph  theory. 

Generally, data involving contact partners within a personal (ego) network are collected 

with the help of network questionnaires and then evaluated by means of quantitative  

analytical software.

Collecting  and  analyzing  these 

data  (number,  density,  centrality 

measures) has so far been carried 

out  using  highly  standardized 

methodologies  requiring 

considerable  effort  from  qualified 

research  staff.  Consequently, 

these methods have their  highest 

value  in  the  processing  of  very 

large  datasets.  Owing  to  their 

complex  quantitative  character, 

they remain inaccessible to users 

in more action-oriented areas of network analysis, remaining ultimately bound to the 

perspective of the detached researcher on the outside looking in.

As of late, there have been endeavors to develop methods that come "closer to the 

actors,  their  perceptions,  interpretations and structures of  relevance"  ([Hollstein  and

Straus 2005], translated from the German). Almost all of these approaches are towards 

a  qualitative  or  "actor-centered 

network  analysis",  a  recently 

established frame which draws on 

the  "social  convoy"  model  as 

developed  by  Robert  Kahn  and 

Toni  Antonucci  in  1980  for 

displaying  social  support 

8

Figure 1: Network of advisors at an academic 
research center; based on a questionnaire survey, 
visualized with the software program UCINET 
([Schönhuth 2007a]) 

Figure 2: Method of concentric circles ("social convoy")  
support persons can be placed into different sections,  
according to their emotional importance as seen by the 
interviewed persons ([Kahn and Antonucci 1980])



structures. Because of their simple structure and the selective way in which the data are 

collected, these models are limited in terms of informative value and empirical validity,  

and therefore not without controversy ([Diaz-Bone 2007]).

Within organizational research and consulting, a branch has emerged in recent years 

which visualizes organization members as involved in a common process suitable as a 

template  for  analysis  and  interpretation.  While  these  techniques  are  successfully 

applied in consulting and development/aid processes both nationally and internationally, 

they  either  come  under  criticism  from  academic  circles  due  to  their  being  neither 

replicable nor representative, or they simply go unnoticed.

In a joint interdisciplinary project 

of  members  of  a  cluster  of 

excellence  at  Trier  and  Mainz 

Universities  in  Germany,  we 

have  tried  to  overcome  this 

gap.1 Our  team has developed 

software  enables  users  to 

interactively  collect  network 

relationship data from an actor's 

point of view and render them comparable and quantitatively analyzable by means of a 

intuitive graphical user interface. While complex questionnaire procedures and specially 

trained staff have dominated thus far, VennMaker allows lay users to map actors and 

their relationships in an intuitive way and generate easily interpretable quantitative and 

qualitative data out of it.  The major benefit of this approach is that interviewees are able 

to visualize and qualitatively evaluate their networks themselves while simultaneously 

reflecting on the network structure and genesis together with the researcher, perhaps 

even considering desirable alterations or the potential for transformation.

Our goal was to develop a tool that is efficiently in these kinds of participatory use 

1 The development of VennMaker draws on long standing experience in the development and application of 
participatory research methodology ([Schönhuth and Kievelitz 1995], [Schönhuth et al. 1998], [Schönhuth
2003], [2007]), in visual data mining and graph drawing ([Pohl et al. 2004], [Pohl et al. 2006], [Pohl 2007]) as 
well as on the professional experience of various other disciplines within the participating universities Trier 
and Mainz, thereby broadening classical social network research with an innovative and unique 
methodological tool.

9

Figure 3: “Venn-diagram”: network of social actors in a 
medium-sized business company in East Germany from 
a management perspective; size of circle = informal  
decision-making power; distance =co-operational density  
/ grade of actor- accessibility for the institution 
([Schönhuth 2007b])



scenarios,  while  at  the  same  time  achieving  scientific  standards  in  generating  and 

processing social network data. Not only is the entire process of generating the network 

map  documented  digitally  (the  choice,  positioning,  and  spatial  distribution  of  actor 

nodes, as well as the drawing of different relation categories, and the strength of ties 

between  them),  but  the  statements  regarding  content  and  importance  of  social  

relationships can be audio recorded during the interview and evaluated later via content  

analysis methods. VennMaker also addresses the structure-agency problem in social  

network analysis, as questions about the structural potential of a network (i.e. social 

capital that could be drawn out of the structure) and the actual use of existing ties by an  

actor can be posed and discussed on the spot.

From the vantage point of the social sciences, this has the potential to narrow the gap 

between  quantitative  and  qualitative  network  research.  There  have  been  many 

developments  in  the  area  of  “qualitative  network  analysis”,  or  “mixed  methods-

methodology” (for Germany see Hollstein/Straus 2006), however, to our knowledge no 

project has solved either the complexity problem in qualitative network maps or the 

issue of interlacing qualitative and quantitative data in a satisfying way. Hopefully, given 

some practical application, time will tell whether we succeeded in going one step further 

with VennMaker.

 Fields of Application

VennMaker holds an advantage in at least four different settings of network generation 

and analysis:

    First, VennMaker  allows  for  participatory,  process-oriented  interviews,  where  the 

client/interviewee and researcher/coach develop and discuss the network map together 

in  a  communicative  process. A classic  field  of  application  would  be  a  research  or 

coaching  situation,  where  the  researcher/coach would  like  to  learn  more  about  the 

socio-strategic setting in which a person (or a group) acts, and the reasoning from the 

point of view of the client(s). This “mental” network map then may act as a starting point  

for  any  kind  of  probing  on  histories,  current  situations, or  future  prospects  of  this 

network.
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    Second,  the  software  allows  for  the  realization  of  self  interviews  without  the 

researcher being present. An assistant system can guide the interviewee through all 

stages of the mapping process step by step, with the help of preconfigured wizards. 

This function makes sense when  a multitude of digital  network maps with the same 

research question must be processed, or in a series of computer-based interviews via 

long  distances. Picture  a  scenario  involving  the  preparation  of  a  conflict-workshop. 

Here, stakeholders or experts could be requested to produce their personal map of the 

actor constellation beforehand while being electronically guided from the preconfigured 

VennMaker. Having evaluated the different personal views, the researcher could then 

begin the workshop with the edited results, illustrating where there is common ground 

and where there are perceived differences which will have to be negotiated.

    Third, VennMaker  is  suitable  for  jointly  generating  strategic  network  maps  of 

organizational branches or projects (“strategic actor mapping”) in a group process. This 

form of application fits nicely in situations where the elicitation and merging of different 

actor views for joint action is a goal. An example would be the actor constellation and 

network developed by the executive board of a medium–sized business company as 

shown in Figure 3  – only that now it would be processed with VennMaker – either using 

a Beamer (allowing everyone to take part in the visualized discussion), or using a more 

cutting-edge interactive whiteboard like Hitachi’s Interactive Board FX Duo.2 

     Fourth, VennMaker  allows  for  the  user-defined  amplification  of  graphical 

representations, which can also be applied as  a user friendly drawing instrument to 

visualize  network  data  that  have  been  surveyed  with  other  analytical  methods 

beforehand. This form of using VennMaker as a pure visualizing tool makes sense in all 

forms of visual presentation of data analyses, be it as a basis for discussion or reflection 

in working groups, or as visualized representations in lectures and publications.

  “Venn” – what’s in a name

What does the name “VennMaker" mean? In Norwegian “Venn” means “brother”, but 

this pun, though it makes sense, has not been the inspiration for our name. “Venn”, first 

of  is  in  reverence  for  the  “Venn  Diagram”,  a  tool  used  with  much  success  in  the 

2 Currently we are launching a project together with Hitachi Software Engineering Europe AG to implement a 
multi-touch option into their whiteboard-series for VennMaker.
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participatory appraisal of stakeholders in development contexts for the last 20 years. Its 

originator was the English mathematician and philosopher John Venn (1834-1923).

To make sense of “Venn” in the way we use it with our software, you might read it also 

as an acronym for “Very Energetic Nice Networks”. As developers. we wish all our users 

this sort of experience when creating networks with VennMaker. In the end, this tool 

derives from the pleasure and gratification that people get when they see their own 

social networks mapped out in such a way that they are able to “visit” it in a beneficial 

communicative  process  together  with  the  researcher/interviewer.  This  manual  is 

designed to guide you on this path as a competent, yet easy to read companion.

Michael Schoenhuth, Trier 5th of June 2009
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2 Introduction

The present manual serves as an introduction to the software VennMaker (Version 1.2).  

All available features of VennMaker are presented here step by step. The text is divided 

into  three big parts.  Free network drawing, configuration and processing of  network 

interviews and exporting of generated data. At the end of this manual you should be 

able to draw social networks, to configure and execute/perform interviews and to export  

the obtained data with VennMaker. This manual is especially addressed to readers who 

are acquainted with the fundamental terms of social network analysis. However, that 

knowledge is not a prerequisite, especially for the free network drawing mode. 

2.1 Starting VennMaker

To be able to execute VennMaker, you need Java (Version 1.6.12 and later). You can 

obtain Java free of charge, visiting http://www.java.com/de/download/. 

You can download a free demoversion of VennMaker from http://www.vennmaker.com

Before you start surveying social networks, you have to install VennMaker. To do so, 

unzip the VennMaker-Windows.zip file and open the newly created VennMaker folder.

VennMaker cannot be run directly from the ZIP archive!

If  you  use  Windows  7  /  XP  /  Vista,  you  can  open  VennMaker  via  “VennMaker-

Windows.exe”. If you have not installed Java on your computer, you will be asked to do 

so after launching VennMaker-Windows.exe.

If you use another operating system (Linux or Mac OS X for example), then you can 

execute VennMaker directly starting VennMaker.jar. 
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Having started VennMaker the following window will open on your computer display: 

The  features  that  are  hidden  behind  the  three  buttons  “Free  Network  Drawing”, 

“Configure Interview” and “Perform Interview” will be explained to you in the following 

chapters. 

All windows in VennMaker are by default in English. You can change the language from 

English to German, Russian, Spanish or Chinese using the selection menu in the top 

right corner. All windows in the “Free Network Drawing” and “Perform Interview” mode 

will then be in the language selected.

In the following chapter we will concentrate on the “Free Network Drawing” mode. 
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Figure 4: Start dialog



3 Free Drawing of Digital Social Network Maps 

Free drawing of digital network maps means that you are not subject to any restrictions 

from the program concerning the design and generation of the network. So, you may 

not only choose actors and relations freely from a range of default designs, but may 

also configure and add new actor types and relations during a VennMaker interview 

session if the situation demands it. 

This mode makes most sense in exploratory interview situations, where the field situation is yet unfamiliar  

or if maximum flexibility and responsiveness vis-a-vis the proband / client's peculiarities and a minimum of 

comparability is requested. Typical for the first scenario are hypotheses-generating research situations; 

typical for the second would be consulting, counseling or coaching situations. 

This  chapter  deals  with  those  functions  which  are  available  in  the  “Free  Network 

Drawing” mode. First, the different areas depicted in Figure 5 will be explained in more 

detail. 
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Figure 5: The „Free Network Drawing“ mode of VennMaker



3.1 The VennMaker Drawing Area

The large white space in the middle of the figure below is called the “digital network  

map”. All visual depictions appear here.

In this area, actors, relations, sectors and concentric circles can be plotted. Every digital 

network map can have different colors and backgrounds, which will  be explained in 

more detail later.
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Figure 6: Digital network map



Ego

In the default setting you will  find the symbol of a human being in the center of the 

empty map, which is labelled “EGO”. Ego by default stands for the person interviewed -  

we deal with “ego-centered networks”. Renaming the center can also signify the project 

or group out of whose point of view the network is designed. The Ego can also be 

moved out of the center to become part of the whole network). 

In Figure  7 you see the ego symbol and its caption and colored background. In this 

case, ego is named “Ego”. If you move the cursor over the ego symbol and right click, 

you will see the following menu:
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Figure 7: The ego symbol

Figure 8: Context menu of Ego



If “Fixed ego” is activated, then the Ego-symbol can't be removed. If you choose “Hide 

ego”, then the Ego-symbol will be suppressed. All relations leading from and to Ego are 

also invisible and removed temporarily from the map then. 

This operation is helpful, if Ego is part of a whole network, meaning, that there is no center, from which a 

network is set up and seen, but any actor has his or her place within the net. It also fits for Ego-centered 

interviews when for setting a stimulus you want to visualize only alteri-alteri  relations, that means the 

relations between the network partners of Ego (“how would the network look like without Ego and his/her 

relations/ties?“). 

If you want to uncover Ego again, just right-click anywhere on the map. You will get a  

drop-down menu where you can click on “Show Ego”. After that Ego with all  his/her 

relations will reappear. 

By  means  of  the  “Relation  Filter”  you  can  hide  all  relations  that  are  not  directly 

connected (adjacent) to ego. This function is useful when many actors are drawn on the 

network map, making it hard to have a clear overview.

“Enlarge”  boosts  the  Ego-Symbol,  “Shrink”  downsizes  it,  with  every  click  one  step 

further. You can also use the mouse wheel for this action. Try which of the functionalities 

fits you better. 

Ego’s name is changed by clicking “Rename Actor” in the context menu. An input field 

opens where you can enter a new name.
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Every actor including ego can be tagged with additional attributes. You can change the 

respective attribute values of an actor via “Attributes”. 

Figure  9 shows  ego’s  attributes.  The  attribute  values  are  changed  by  clicking  the 

appropriate cell. In the case of categorical attributes, a selection list with the respective 

categories opens. In the case of freeform answers, you can type the attribute value in a 

text box. Changes are applied to the actor immediately.

How you define or edit new attributes is explained in the chapter 3.4.
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Figure 9: Attribute dialog



Legend

A legend is shown by default in the bottom left corner of the digital network map (see 

Figure 10).

The legend contains all  attributes and attribute values used in the network map and 

which are linked to visualizations. These could be symbol size, symbol type, relation 

lines, sectors or concentric circles. In Figure  10 you can see the default legend. If a 

symbol or relation line is deleted, altered or added, the key is automatically updated.

The legend will be hidden by clicking on an unused space of the digital network map 

with the right mouse button. A menu will open (see Figure  11) where you can choose 

“Hide Legend”. Thereafter, the legend will be hidden. 

20

Figure 10: Legend with default values

Figure 11: Context menu of the digital network map



This also applies for displaying the legend. There is only one difference referring to the 

menu. Now it contains a new menu item named “Show Legend”. 

In this chapter you have learned to change some parameters of Ego as well as hiding 

the legend of the digital network map. The following chapter will explain how to draw 

other  actors  (resp.  alteri  /  nodes)  on  the  one  hand  and  how  to  draw  relations 

(respectively ties) between the actors on the other hand. 

3.2 Akteure und Beziehungen einzeichnen

The following default menu is found on the left side next to the digital network map:

In Figure  12 you can see three areas: “Action”, “Actor Type” and “Conflict (standard 

relation)”. The last item is abbreviated. If you move the mouse over these items, a small 

text box (called Tooltip) with the full text appears.
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Figure 12: Menu for Undo/Redo and for drawing actors and relations



Undo / Redo

The upper  “Action”  field  contains an “Undo”  and a “Redo”  button.  If  you notice,  for 

example while drawing a network, that you have made a mistake, you can use the 

“Undo” button to undo all actions step by step. Using the “Redo” button, you can restore 

an action that has been undone.

Actor Type

When  launched,  VennMaker  creates  the  attributes  “Importance”,  “Actor  Type”  and 

“Age”. Additionally, the attribute values of the “Actor Type” attribute are represented by 

symbols.  In  Figure  12 you  see  the  attribute  “Actor  Type”  with  its  attribute  values 

“Institution”, “Male”, “Female” and “Other” along with their respective symbols. 

If you click on one of the symbols and then click on the digital network map, VennMaker 

will ask you to enter a name, and then the symbol selected along with the name will be 

displayed on the network map. You have created an actor whose attribute “actor type” 

has been given an appropriate attribute value. This value is represented by its symbol.

An example:  You would like to  add the actor  Peter  to  the  network map.  First,  you 

choose “Male” on the left under “Actor Type”. Then you click on the desired position on 

the network map and enter the name Peter. Afterwards, the male actor Peter is shown 

on the network map (see Figure 13).

How you set which attribute value is represented by a symbol is explained in chapter  

3.4.4.1.
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Figure 13: Actor name and the actor value is visualized by a symbol



An actor that has already been added to the network map can be re-positioned by left  

clicking the symbol on the network map and, while keeping the mouse button pressed, 

moving it.  

If  you  right  click  on  the  symbol  on  the  network  map,  the  following  context  menu 

appears:

Use “Remove Actor from this Network Map” to remove that actor from the current digital 

network map. The actor will  appear in the left  section under “Available Actors”.  The 

actor is for all intents and purposes ‘parked’ on the edge of the network map. 

You can completely delete an actor from the interview by using “Remove Actor from 

Interview”. 

Use “Enlarge” and “Shrink” to change the size of the actor symbol.

You can also change the size of a symbol by moving the mouse over it and then using 

the scroll wheel on the mouse. 

However, to be exact, you are not actually enlarging or shrinking the actor symbol, but rather the value of  

the attribute. VennMaker correlates the relative value of an attribute with a pre-defined symbol size. If the 

attribute value is changed, the symbol size changes accordingly. 

How this correlation can be changed is explained in the Triggers chapter 3.4.4.5.
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Figure 14: Context menu of an actor



Use “Rename Actor” to change the actor name.

Via  “Attributes”  you  can open  another  window where  you  can  change  the  attribute 

values of the actor:

You can also open this window by double clicking on one of the symbols.  You can 

change the attribute values by clicking the appropriate cell in the “Value” column.
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Figure 15: Attribute dialog of an actor



Drawing Relations

In  Figure  16 you  see  the  “Relation  (Stand...)”  field  and  its  three  characteristics: 

“positive”,  “neutral”  and “negative”.  Every  relation  characteristic  is  represented by  a 

different type of line. To see the full text of the various labels, move the mouse over  

them.

By default VennMaker uses relations that run in both directions. The same relation runs 

between Actor A and B as between Actor B and A. To ensure clarity, no arrows are used. 

In the relational attribute chapter 3.4.5 you will learn how to set up directed relations. 

Relations are plotted on the digital network map by clicking the appropriate button (e.g. 

“neutral”). Then click the actor from whom the relation should start on the digital network 

map and, keeping the left mouse button pressed, drag the line to the second actor (for 

best results, drag the line to the middle of the symbol) and then let the mouse button go.  
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Figure 16: Menu for the default relation



Now both actors are connected by a line. By right clicking on the relation, a selection  

menu appears (see Figure 17).

“Delete Relation” deletes the relation drawn on the map.

The  function  “Reverse  relation  direction”  is  deactivated  here  because  no  directed 

relation  is  used.  If  a  directed  relation  is  set  up,  then  “Reverse  Relation  Direction” 

changes the direction of the line and arrow. 

Use “Attributes” to open a window for changing relation attribute values:

If you add multiple relation lines of different types between the actors, then these lines 

are automatically displayed next to each other.
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Figure 17: Context menu for the relation

Figure 18: Dialog for the relation attributes



3.3 Digital Network Map

The digital  network  map is  the drawing area in  VennMaker.  The following chapters 

explain how you customize the digital network map, clone or add additional maps. 

When you click  on  “File”  in  VennMaker’s  upper  menu bar,  a  toolbar  (also  called  a 

ribbon) opens (see Figure 19).

The toolbar  is  divided  into  four  functional  areas:  “Interview”,  “Action”,  “Import”  and  

“Export”.
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Figure 19: The menu bar



3.3.1 Project, Interview and Network Map

First the concepts project, interview and network map will be explained. Then you will 

be shown how network maps and interviews are saved in project files and then loaded 

again from the project files. 

The following diagram illustrates the relationship between project, interview and network 

map:

Project „Migration“

Interview „Person A“

Netzwerk Map 1

Netzwerk Map 2

Interview „Person B“

Netzwerk Map 1

Netzwerk Map 2

Figure 20: Relationship between project, interview and digital network map

A project,  in  this  example a project  on the inter-relation of  migrants  in  rural  areas, 

contains two ego-centric  interviews (Person A,  Person B).  Each interview uses two 

digital network maps (in each case Network Map 1 and Network Map 2).

In general, each interview contains at least one network map. Network maps are always 

a part of an interview. An interview is always part of a project. 

VennMaker uses this division when saving projects. All interviews from the project are 

saved in the project file. This means that all  images and symbols, the network map 

creation log and the recorded audio files are all saved in this project file. This ensures 

that all interview data are centrally collected in one project file.

3.3.2 Saving an Interview

The “Interview” function allows you to create a new interview, open an existing interview 

and save an interview. 
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All interviews are saved in a project file. The project file ends in “.vmp” (VennMaker 

Project). 

An interview can be saved via “Save” or “Save As…” The difference between “Save” 

and “Save as…” is that “Save” only opens the save window (see Figure 21) if you have 

not yet selected a project and interview where the network data should be saved. “Save 

as…” always opens the save window:

When you save your interview for the first time, you first must select a directory where 

the project that contains the interview should be saved and give the project a name:
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Figure 21: Save dialog



You can  either  create  a  new project  by  entering  a  new project  name or  select  an 

existing project file. 

Finally, click “OK”.

The name of the project file now appears in the first line of the save window (cf. Figure  

23). If the project already contains further interviews, the interview names will be listed 

in the “Project Contents” section.
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Figure 22: File browser for saving projects

Figure 23: The project content dialog



You can also enter a new name for your interview in the lower input box and then click 

“Save”. Your interview will then be saved as a new interview in the project file. 

After you have saved your interview, the project path and name, and the name of the 

interview will appear in the VennMaker menu bar (cf. Figure 24):
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Figure 24: Project path, project name and interview name



3.3.3 Deleting an Interview

You can delete an interview via the save window (cf. Figure 21).

The “Delete” button removes the interview from the project. First click on the interview in 

the “Project Contents” section and then click “Delete”. VennMaker will then ask if you 

are sure you wish to delete the selected interview. After you have confirmed this, the 

interview will be removed from the project.

3.3.4 Creating a New Project and Interview

A new project and interview are created as follows:

Click “New” once and the following menu opens:

Here  you can choose between  “New Project  and Interview”  and  “New Interview in  

Current Project”. If an interview is still open, VennMaker will ask whether you are sure 

you want to start a new project and whether you want to close any open digital network 

maps. Once you have confirmed, a new project will be created. 

If you have not yet opened a project, the second function “New Interview in Current  

Project” will not appear.

The difference between these two functions is that “New Project and Interview” will not 
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Figure 25: Create a new project and interview



allow you access to the current project’s attribute symbols and only the VennMaker 

symbols will be available. With “New Interview in Current Project” you still have access 

to the attribute symbols of the project. 

How you can add your own attribute symbols to your interview and project is explained 

in chapter 3.4.4.1.

3.3.5 Opening a Project and Interview

You can open a project by clicking “Open”. A menu with two functions will appear: “…

from current project” and “…from another project” (cf. Figure 26). The second function 

“… from another project” will only appear if an interview is open. 
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Figure 26: Open an interview



If you choose “… from current project”, the following window opens:

All interviews that have been saved in the project are listed in the field labeled “Project  

contents”. You can open an interview by clicking one of the entries and then clicking 

“Open”.

You  can  delete  an  interview by  clicking  the  interview in  the  list  and  then  pressing 

“Delete”.
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Figure 27: Open an interview from current project



If you select “… from another project”, the following window opens:

Here you can select the desired project and click “OK” to open. The project files all have 

the file extension “.vmp”. 

You  can  open  older  venn  files  (VennMaker  Version  1.1.1  and  earlier)  by  selecting 

“.venn” from “Filter”. All files ending with “.venn” will then appear and can be opened by 

clicking “OK”.

3.3.6 Add and Clone Network Maps

In the menu bar (see Figure  19) there is a button labeled “Add Network Map” in the 

“Action” section. If you click this button, VennMaker opens a selection menu for creating 

(“Add Blank Network Map”) a new network map as well as for cloning (“Clone Network 

Map”) the current network map (see Figure 29).
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Figure 28: Open an interview from an other project



“Add Blank Network Map” adds a new digital network map to the interview. 

“Clone Network Map” generates an exact copy of the current network map.

If  you click either of the menu buttons, VennMaker will  ask you to name the digital 

network map to be created. Only then will VennMaker create the map. A new tab will  

appear on the border at the bottom of VennMaker (see Figure 30).

You can switch between the digital network maps by clicking the tabs.

You can change the tab order via drag & drop: click on a tab and, while keeping the 

mouse button pressed, drag it to the desired tab position. 
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Figure 29: Create or clone a network map

Figure 30: Digital network map tab



If you wish to re-name a network map then right click on the appropriate tab and select 

“Rename Network Map” (cf. Figure 31). 

If  you  would  like  to  remove  a  network  map  from  the  project,  right  click  on  the 

appropriate tab on the bottom border of VennMaker and select “Delete Network Map” 

from the context menu (cf. Figure 31).

Now that you have learned how to create, save, delete and duplicate digital network 

maps, the following chapters will explain how you can configure a digital network map.

3.4 Attributes

Non-relational and relational features are compiled in every classical survey. This is also 

possible using VennMaker, although here the term “Attribute” is used instead of feature. 

Actors in VennMaker can have various attributes, which can be configured individually. 

Examples of such attributes are age, sex of a person or type of institution, etc.

3.4.1 Edit Attributes

Attributes can be set  via  the configuration window as follows:  Use the right  mouse 

button to click on an open area of the network map and select “Configuration”. Then 

select the function “Attributes” under “Project” in the configuration window:
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Figure 31: Context menu of the network map tab



All  available  attributes are listed in  the open window and there are three functions: 

“Edit”, “New” and “Delete”.

However, the functions “Edit” and “Delete” are only available once an attribute from the 

list “Label” has been clicked. 

A new attribute is created by pressing “New” and then entering an attribute label:

Delete an attribute as follows: select the appropriate attribute from the list and then click 

“Delete”. You will not be asked whether you want to delete the attribute! 
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Figure 32: List of the non-relational attributes

Figure 33: Input a new attribute label



An attribute can be changed by selecting it from the list and then clicking “Edit”. This 

window will open:

In VennMaker, every attribute is composed of a relation, an issue, a description of the 

attribute, the scope and an answer. 

The attribute relation allows the attributes to be differentiated from one another. 

Every attribute can be given a question.  Open ended answer and Categorical are the 

two answer possibilities.  Open ended answer allows any open answer to be entered, 

whereas with Categorical only pre-formulated answers can be selected. 
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Figure 34: Dialog for configuring an non-relational attribute



For the quality of the survey it is important that researchers can store further information 

about the attributes. For this, you can use the description of the attribute. 

The scope specifies whether the answers given apply to all network maps within the 

same  interview  or  whether  every  individual  network  map  should  be  given  different 

answers. The latter is attractive, for example, when collecting data at different times as 

actor characteristics can vary between different time periods (e.g. income, status). 

New categories can be added using “New” and existing categories can be removed 

using “Delete”. 

The  Default  Value specifies  whether  a  particular  category  should  be  set  up 

automatically when a new actor is created. 

The order  of  the  attribute values can be changed using  drag & drop.  Click  on the 

desired entry in the “category” column. Keep the mouse button pressed and drag the 

entry  to  a  new position within  the column and then release the mouse button.  The 

selected entry has now switched positions with the other entry.
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3.4.2 Configuring Relational Attributes

A social network contains, in addition to actors, social relations that exist between these 

actors. Relations are represented by relational attributes in VennMaker. For example, 

the relation “money borrowed” is a relational,  categorical attribute with,  for  instance, 

three response categories: “€0-1000”, “€1001-2000” and “€2001-3000”. In addition to 

relational,  categorical  attributes,  relational  attributes  allowing  text  input  can  also  be 

defined. This enables, for example, every relation to be tagged with commentary. 

Relations can be combined to form relation groups as well. An example: The relation 

group “Social Support” contains two relations: “money borrowed” and “tools borrowed”. 

In  VennMaker,  you  can  define  and  change  certain  relations  via  “Configuration”  > 

“Relations”:
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Figure 35: Dialog for configuring a relational attribute



In the configuration window for the relation attributes there is a selection menu below 

the information text which can be used to define relation groups.

Relation Groups

A relation group combines multiple relational attributes. This enables, for example, a 

relation with a categorical  attribute and an annotated attribute to be created. In this 

case, the relation group stands for a relation that can additionally be annotated. 

If you wish to create a new relation group, click “New”. VennMaker will prompt you to 

name the relation group and then to name the first attribute. After you have done this, a 

configuration window for the attribute will open. This window is nearly the same as that  

for  non-relational  attributes,  with  the  difference  that  you  can  configure  relational 

attributes (cf. chapter  3.4.1). After you have configured a non-relational attribute and 

clicked “OK”, this attribute will be listed in the new relation group.

VennMaker allows you to use directed and undirected relations. Undirected relations run 

in both directions between two actors. Directed relations, on the other hand, run in only 

one direction, from one actor to another. Directed relations can be depicted with an 

arrow. Undirected relations are depicted with a simple line instead. If you would like a 

relation  group  containing  only  directed  relations,  then  click  the  box  to  the  left  of 

“Directed Relation”.  A check will  appear  in  the  box.  If  you click  the  box again,  the 

checkmark will disappear and you have switched the relation group back to undirected 

relations. 

If you would like to delete a relation group, select the desired group in the selection 

menu and click “Delete”. Once you have confirmed that you wish to delete it, the relation 

group and all the attributes in it will be removed.

VennMaker prevents you from being able to delete all relation groups; therefore, you 

can only delete a relation group if at least one other exists.

Relational Attributes
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A relation  group  contains  one  or  more  relational  attributes.  These  attributes  are 

displayed in a table in the configuration field. 

You can create a new attribute using the button “New Attribute”. The window is similar to 

the one for non-relational attributes (cf. chapter 3.4.1). 

3.4.3 Inputting and Editing Attribute Values

In the previous chapter you learned how non-relational and relational attributes can be 

created. This chapter shows you how to input attribute values.

3.4.3.1 Inputting Non-Relational Attribute Values

If  an  attribute  has  been  defined,  a  user  can  then  enter  attribute  values,  or  rather  

answers in one of two ways: either for each actor individually or by using an actor table 

which contains all actors and their attributes and attribute values. 

To begin with, the first input option will be dealt with, which proceeds using the following 

steps: Right-click on an actor and then select “Attributes” from the context menu.

Then a table opens which contains all attributes and their actor-specific attribute values. 

(You can also open the table by double-clicking on the actor.)
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Figure 36: Context menu and attributes



All actor attribute values can be changed in this table:

If the attribute was previously tagged with a question, this question will appear in the 

table, otherwise the attribute labels will be used (e.g. “Importance”).

You can change an attribute value by clicking the appropriate cell in the column “Value”. 

If it is a categorical attribute, then a list with response categories will appear. If it is a  

non-categorical attribute, an input box will appear.

Actor Table

The second possibility of changing attribute values is to use the actor table. This can be  

accessed via the menu item Analyse > Actor Table. 

The first row contains the attribute labels. All the actor names are listed in the far left  

column. The columns to the right of that contain all the attribute values for that actor. By 

clicking the appropriate cell in the table, you can change the attribute values. 
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Figure 37: Attribute dialog of an actor



The advantages of using the actor table are the clear overview and the ability to quickly 

input many attribute values.
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Figure 38: The actor and attributes table



3.4.3.2 Inputting Relational Attribute Values

Relational attribute values such as the extent of financial support can be input in two 

ways: by selecting the appropriate relation line while drawing a line or by using the 

attribute window for each relation line that is drawn on the digital network map.

Setting Attribute Value by Selecting the Appropriate Relation Line 

Relational, categorical attribute values can be set by selecting the appropriate line in the 

menu on the left:

For example, if you select “€1000-2000” under “Financial support” (cf. Figure  39) and 

then  draw  a  relation  line  between  two  actors,  the  attribute  value  of  the  relational 

attribute will be set as “€1000-2000”.
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Figure 39: Menu for the relational attributes



Attribute Window

The attribute window for a relationship’s relational attribute values can be opened by 

right-clicking on the desired relation line.

A context menu will open. Click on “Attributes”.

The  attribute  window  had  two  columns,  “Attribute”  and  “Value”.  The  first  column 

contains the attribute names and the questions formulated, and the second column has 

the attribute  values and answers.  You can click on  a cell  in  the  “Value”  column to 

change its value.
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Figure 40: Context meu and relational attributes

Figure 41: Dialog for editing relational attribute values



3.4.4 Visualizing Attributes

Sometimes it is important to integrate non-relational attribute values into the network 

picture as visual information, for example to use them as a stimulus for further surveys. 

In Figure 42, four actor attributes are displayed: name, emotional importance, sex and 

role (family member, friend, co-worker).

The attributes (with the exception of actor name) are visualized using symbols (= sex), 

symbol size (the larger the symbol, the larger the emotional importance) and sectors 

(blue=  family  member,  purple=  friend,  green=  co-worker).  The  viewer  can  easily 

interpret which actor is emotionally important (Anna), which actors fill multiple roles and 

which sex the actors are. 

Below you will find instructions for visualizing non-relational attributes in VennMaker.

An actor and its attributes can be displayed with various visual components:
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Figure 42: Example for visualizing non-relational attribute values



Actor Diagram 

Segment:
Color

Symbol:

Size

Pattern

Actor label

First  we  will  look  at  the  attribute  symbol.  This  is  the  only  visual  component  in 

VennMaker that is mandatory and not optional.

3.4.4.1 Attribute symbol

An actor  can be described by one or  more attributes,  whereby categorical  attribute 

values can be represented by additional symbols on the network map. An example is  

the  sex  of  the  actor,  which  is  represented  by  the  corresponding  symbol.  Attribute 

symbols  can be individually  set  for  every  digital  network  map.  To  do  so,  open the 

configuration  window for  attribute  symbols  by  right-clicking  on an open area of  the 

digital network map and selecting “Configuration” from the selection menu. Then in the 

configuration window, click on the sub-menu function “Attribute Symbol”:
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In the right section of the configuration window, you will see, under the information text,  

the attribute (in this case “Actor Type”) and two buttons for editing the attribute selected 

and for adding a new attribute.

You can choose another categorical attribute by clicking on the dropdown list to the right  

of “Attribute”. 

You can create a new categorical attribute with “Add New Attribute”; you can edit the 

attribute selected with “Edit Attribute” (cf. chapter 3.4.1). 

Below this there is a table that contains the attribute value of the selected attribute (here  

“Actor Type”) in the first column. The second column has the corresponding symbols. 

You can change a symbol  by clicking the appropriate cell.  You will  then be able to 

preview all available symbols. Click on the desired symbol. It will then be shown in the 

respective cell and is now associated with this attribute value. 

If no symbols have been selected, VennMaker uses a standard symbol (a white circle 
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Figure 43: Config dialog for editing the attribute symbols



with a black border). 

You can use your own symbols by clicking the button “Add Icon(s)”. You will then be 

prompted to select the desired file. You can only add image files that have been saved 

in SVG format.

The website http://www.openclipart.org/ offers a large collection of various images in SVG format. You can 

create your own images using the graphic program Inkscape (http://inkscape.org).

Use “Delete Icon” to remove symbols. Select the symbol to be deleted and then click 

“Delete”.

Once you have made your changes, you can apply them by clicking “OK”.

3.4.4.2 Linking Symbol Size to Attribute Value

An actor’s categorical attributes can be visualized using the size of the attribute symbol.

An example is the emotional importance of an actor, displayed using the corresponding symbol size. If an 

actor is “very important” to ego, then this attribute value “very important” can be shown using a large 

symbol.  However, if an actor is “hardly important”, this value can be shown using a small symbol.

The symbol size can be set separately for every digital network map. To do so, open the 

configuration window by right-clicking on an open area of the digital network map and 

select “Configuration” from the menu. Then click the sub-menu function “Symbol Size” 

in the newly-opened configuration window:
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In the right section of the configuration window below in the information text you can see 

the selected attribute (here “Importance”) and two buttons for editing this attribute and 

adding a new attribute.

You can select another categorical attribute by clicking on the dropdown list to the right 

of “Attribute”. 

Create a new categorical attribute using “Add New Attribute”; edit the selected attribute 

using “Edit Attribute” (cf. chapter 3.4.1).

The window includes a dropdown list with the respective categorical attributes. 

The available  response categories and attribute values of the selected attribute are 

displayed  in  the  two  columns of  the  table  below.  Every  row contains  an  response 

category with the corresponding example symbol in the appropriate size. By clicking the 

symbol, you can open a selection list with all available symbol sizes. 
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Figure 44: Config dialog for changing the symbol size



If another attribute is selected, the symbol size is then set to the standard size. 

The settings are applied by clicking “OK” in the configuration window. 

Which sizes make sense depends on the research question. You should keep in mind 

that a symbol, depending on its size, may overlap with the concentric circles. Then it is 

no longer possible to see which concentric circles belong to which symbol.

The example in Figure 45 illustrates the problems that can appear when using different 

symbol sizes with the maximum number of sectors and concentric circles. Depending 

on the size, the symbol size can exceed the concentric circle. When using concentric 

circles and sectors, please note that the space available for text in a sector decreases 

the closer it is to ego. Furthermore, the difference between symbol sizes can be difficult 

to see when only small size differences are used. There should always be a balance 

between the intervals in size not being too small and the final size not being too big. 

Figure 45 can help you with a sensible selection:
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3.4.4.3 Actor Diagram

The actor diagrams can show whether certain attribute values have been selected or 

not. 

An example: The actor diagrams allow you to easily display whether an actor has multiple roles.  For this  

you can set, for example, three categorical attributes: family member, co-worker, friend. Each of these  

attributes contains two answers: “true” and “not true”.

An actor diagram sector can be connected to each “true” attribute for these three attributes. If “true” is  

selected for this attribute value in an interview, then the relevant segment will appear for the actor. 

The actor diagrams can be set up individually for every digital network map.  To do so,  
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Figure 45: Maximum range (1-10) and “practical” actor sizes for different number of actor 

categories (2 to 5) 



open the configuration window by right-clicking an open section of the digital network 

map  and  then  select  “Configuration”  from  the  selection  menu.  Then  select  “Actor 

Diagram” from the submenu in the configuration window.

The window in Figure  46 contains a button for adding a new categorical attribute (cf. 

chapter  3.4.1)  and  a  table  with  four  columns:  “Attribute”,  “Display  which  value?”, 

“Segment Color” and “Edit Attribute”.

The first column shows the available categorical attributes. 

In the second column you can select an attribute value which, when given as an answer  

in an interview, should be displayed as an actor diagram segment. An attribute value 

can be set using the selection menu that opens when you click on the appropriate cell in 

the second column. If no attribute values should be displayed as diagram segments,  

then choose the first entry on the selection list, which is a blank line. 

If an attribute value has been selected in the second column, then the segment color  
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Figure 46: Config dialog for editing the actor pie



can be selected in the third column. When the relevant attribute value is later given as 

an  answer  in  an  interview,  then  the  corresponding  actor  diagram  segment  will  be 

displayed. 

You can edit the attribute values using the “Edit” button in the fourth column (cf. chapter 

3.4.1).

3.4.4.4 Actor name

You can change an actor’s name by right-clicking the relevant actor and then selecting 

“Rename Actor” from the menu and entering a new name. Additionally, you can position 

the  actor  name  by  choosing  “Configuration”  in  the  above  menu  and  then  “Label 

Behavior”. The configuration window for the alignment of the actor’s name will open:

Here you have five possibilities for  aligning the actor  name (also called  label).  The 
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Figure 47: Config dialog for changing the actor label



changes are applied to all network maps for that interview. 

Actor names can also be encrypted. You can learn more about that in chapter 3.12.

You  will  also  find  a  table  in  the  configuration  window with  the  columns “Attribute”, 

“Display Value”, “Display Value in Tooltip”. 

Every cell contains an attribute. In the second column you can set whether the attribute 

and its entered attribute value should be displayed in the actor label. 

In the third column you can set whether the attribute and attribute value should be 

displayed in the tooltip.

Figure 48 shows the results of the settings in the second column and Figure 49 shows 

the tooltip that opens when you move the mouse over an actor (in this case ego).
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Figure 48: Attributes und attribute values displayed below the actor symbols



3.4.4.5 Trigger

Attribute values in VennMaker can be set not only by using the input table, but also 

indirectly by using the mouse wheel or VennMaker’s symbol menu.

These two input methods (mouse wheel / symbol menu) are called triggers; when the 

mouse  wheel  is  used  or  a  symbol  is  selected,  they  trigger  a  change  in  the 

corresponding attribute value. 

Triggers can only be used for categorical attributes, they are set as follows:

First open the configuration window by right-clicking an open area in the digital network 

map and then selecting the “Configuration” function. The configuration window will open 

and you can select the area labeled “Trigger”.
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Figure 49: Attributes und attribute values displayed in the tooltip



The window contains various selection menus:

The  first  two  menus  apply  to  non-relational  attributes.  The  other  menus  contain 

relational attributes. 

In the first  selection menu, you can configure which attributes you would like to set 

using the symbol menu. 

In VennMaker, the attribute “Actor Type” is set by default for use with the symbol menu. 

The attribute values “Organization”, “Male”, “Female” and “Other” are available and can 

be displayed using the respective symbols.  How you can create a link between an 

attribute value and a symbol is shown in the Attribute Symbol chapter 3.4.4.1.

In  the  second  selection  menu,  you  can  assign  the  mouse  wheel  an  attribute.  In 

VennMaker, the attribute “Importance” with the attribute values “less important” to “very 
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Figure 50: Config dialog for editing the Trigger



important” is set by default.  If you roll the mouse wheel upwards during an interview, 

then the next attribute value above “less important” is selected. If the mouse wheel is  

rolled  in  the  other  direction,  then the  next  attribute  value  below “very  important”  is 

selected. You can set the order of the attribute values in the configuration window in the 

“Attribute” section (see chapter 3.4.1). 

This default setting is particularly convenient because the symbol size is linked to this  

attribute. Thus the symbol size changes when the mouse wheel is used. This happens 

as follows: the mouse wheel is moved, the attribute is set to the next attribute value and 

the  symbol  is  shown  in  the  appropriate  size.  How  you  can  link  symbol  size  to  a 

categorical attribute is shown in chapter 3.4.4.2.

Use the other menus to set which relational attribute should be displayed in the side 

menu on the left. Every attribute value is then represented by its own button, on which a 

line and the attribute value are shown.
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3.4.5 Visualizing Relational Attributes

There are three ways to visualize relational attributes: line color, line weight and line 

pattern.

To change the appearance of a line, use the three configuration sections: “Relation 

Color”, “Relation Thickness”, “Relation Dashing” in the configuration window for every 

network map. 

All three sections are set up similarly (cf. Figures 51, 52 and 53)). You can configure the 

relation groups and the corresponding relational categorical attribute. There is also a 

table  with  two  columns.  The  first  column contains  the  attribute  values;  the  second 

column contains the settings for visualizing these (color,  line width, dash style).  The 

respective entries can be changed by clicking the cell.
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Figure 51: Config dialog for changing the relation colors
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Figure 52: Config dialog for changing the relation thickness
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Figure 53: Config dialog for changing the relation dashing



3.4.6 Customizing the Digital Network Map

This chapter shows how you change the title, background color, background image and 

size of a digital network map and how you can add a network map as the background 

image within an interview.

Changing the Title of a Network Map

First, you will learn how to show the name of a network map as a title. Every digital  

network map is given a title by default:

The title is the name of the digital network map, in Figure 54, for example, the title of the 

network map is “Network 2006”.
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Figure 54: The network map title



You can align the title by right-clicking:

The title can either be hidden (“Hide Network Map Name”) or be shown in either at top 

left  (“Draw Left”) or  at  the top right (“Draw Right”) of the network map, or centered 

(“Draw Centered”).

Changing Background Color, Image and Size of the Digital Network Map

The background color, background image and size of a digital network map can be set 

in two ways: either right-click on an open section of the digital network map, choose 

“Configuration”  and  then  “Set  background”  or  select  “Configuration”  >  “Background 

Image” from VennMaker’s menu bar. 

No matter which method you use, you will see this window:
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Figure 55: Changing the network map title position



In the “Background Color” section you can set the background color using the “Select” 

button. You can select the transparency of the background color using  “Color”. The 

higher the value, the less transparent the background is. 

If  you  would  like  to  use  a  background  image,  then  click  the  box  labeled  “Use 

Background Image”. Then select an image file using “Select”. The image file must be in 

either pmg or jpg format. 

Once an image has been selected, you will be able to preview it. 

Using the “Size and Proportion” selection menu you can set whether the background 

image’s size needs to be adjusted or not.  Selecting “Retain Image Size”  keeps the 

image in its original form. Its size will not be adjusted. “Adjust Image (height & width)” 

adjusts the height and width of the image to fit the size of the network map. “Retain 

Aspect  Ratio  (height)”  adjusts  the  background  image  to  fit  the  network  map  while 
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Figure 56: Config dialog for changing the background color and background image



keeping the original ratio between height and width. Using this setting, the background 

image will  have the same height as the network map. “Retain Aspect Ratio (width)” 

adjusts the background image to fit the network map while keeping the original ratio 

between height and width. Using this setting, the background image will have the same 

width as the network map. 

The background image is only applied to the current digital network map.

If you wish to use only a portion of the image as a background, you can do so using 

“Select Section”. 

Changes are applied after the “OK” button has been clicked.

Using a Network Map as a Background Image

If you have multiple network maps in an interview, then you can use on or more of these  

network maps as an additional  background to another network map. Network maps 

from different interview files cannot be used!

For  example:  you  have a  network  from the  year  2010  and one  from 2011  in  your 

interview and you want to be able to visualize the differences between the two.

First choose the network map you would like to insert in the other network map. In this 

example, the network map from 2010 will be inserted as the background image in the 

network map from 2011. To do so, the network map “2011” is selected:

After that, right-click on an open section of the network map and open the configuration 

window under “Configuration”. Then go to “2011” in the “Network Map” section and open 

the  “Background  Network”  window.  Finally,  click  on  the  “Insert”  button.  VennMaker 

automatically adds all other network maps to the “Network Map as Background” list:
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In this case, the network map “2010” is added to the list. 

Click “OK”.

VennMaker now displays the inserted network map as the background image in the 

network map “2011”:
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Figure 57: Insert an other network map as a background image

Figure 58: Two network maps in one network map



Changing the Network Map’s Aspect Ratio

Via “Configuration” > “Aspect Ratio”, the height and width of the network map in use can 

be changed (see Figure 59).

While drawing on the digital network map, it is possible to hide the toolbar. 

To do so, click on the button in the top right corner of the network map (see Figure 60). 
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Figure 59: Changing the  height and width of a network map

Figure 60: Button for switching off and on the menu



Click again to show the toolbar.

3.5 Using Concentric Circles and Sectors

With  VennMaker,  actor  attributes  can also  be queried  using  sectors  and concentric 

circles. These functions are accessible via VennMaker’s menu item “Configuration” (see 

Figure  61).

The number of concentric circles and sectors can be set via “Sectors” or “Circles” or via 

the configuration window, which is opened by right-clicking on an open area of the 

network map.

In the right area of the configuration window below the information text you will see the 

preset attribute (here “Role”) and two buttons for editing the selected attribute and for 

adding a new attribute. 

You can select another categorical attribute by clicking the dropdown list to the right of 

“Attribute”.  After you have selected an attribute, VennMaker will show you a preview of 

the sectors. 
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Figure 61: Config menu



You can create a new categorical  attribute via  “Add New Attribute”;  you can edit  a 

selected attribute via “Edit Attribute” (cf. chapter 3.4.1).

“Transparency”: If you are using a background image, it is often better when the sectors 

do not completely cover the image. Using the scroll bar you can set the transparency. 

The farther to the right, the more transparent the sectors are. 

In  the  lower  area  of  the  configuration  window there  is  a  table  with  three  columns 

“Value”, “Color” and “Select Color”. 

The attribute values of the selected attribute are shown in the “Value” column.

The second column “Color” contains the respective sector colors that are associated 

with the attribute values. The colors can be changed using the button that is in the same 

row, in the “Select Color” column. 

You can change the sector size directly using the sector diagram pictured in the window. 
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Figure 62: Config dialog for changing the sectors



At the edge of the circle, move the lines dividing the sectors.

The order of the sector labels can be changed using drag & drop within the column 

“Value” in the table. Click an entry and keep the mouse button pressed. Then drag the 

entry to another position in the column and let the mouse button go. This change has no 

influence on the actual order of attribute values; it only applies to how the sectors are 

displayed.
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Configuring Concentric Circles

Figure 63 shows the configuration window for concentric circles:

In the right section of the configuration window below the information text you can the 

preset attribute (here “Distance”) and two buttons for editing the selected attribute and 

for adding a new attribute. 

You can select another categorical attribute by clicking the dropdown list to the right of 

“Attribute”.  After  you have selected an attribute,  VennMaker will  display its  attribute 

values in the “Value” column in the table at the bottom 

A new categorical  attribute can be set  using “Add New Attribute”;  you can edit  the 

selected attribute using “Edit Attribute” (cf. chapter 3.4.1).

If you click on the column caption “Value”, the order of the attribute values changes. 
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Figure 63: Concentric circles



This change applies to the order of circle labels. The first table entry is the outer circle, 

the last entry the inner-most circle (cf. Figure 63 and 64). The actual order of attribute 

values for that attribute is not changed.

74

Figure 64: Concentric circles and spatial distances



3.6 Filters

Graphic  querying  of  social  relations  can  quickly  become confusing  and  error-prone 

when there are an increasing number of  actors.  To avoid this  problem, VennMaker 

offers filter functions so you can selectively hide and show actors and relations.

3.6.1 Attribute Filter

The attribute filter allows network nodes and network relations to be hidden or shown. 

Using  non-relational  attributes  and  relational  operations  (less,  less  equal,  equal, 

unequal, greater, greater equal), you can define conditions that can be combined using 

logical operators (AND, OR). 

This allows, for example, the following filter conditions to be defined: show all female 

actors who are older than 45.

If an actor fulfills all conditions defined in the filter, then the actor will be displayed in the  

digital network map. If an actor does not, then he/she and all connected relations will be 

hidden. 

You can open the filter window via “Filter” > “Set New Filter”:
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Figure 65: The filter menu



In this example, the window contains four selection menus. Going from left to right, the 

first menu contains the attributes, the second the relational operators (less, less equal,  

equal, unequal, greater, greater equal), the third menu contains the attribute values for  

the attribute selected in  the first  menu.  Additionally,  there is  also an entry  “Missing 

Value” that represents all attribute values not entered. In the case of non-categorical  

attributes, a value can be entered into the third field. If you would like to add additional 

conditions,  then  you  should  select  a  logical  operator  from  the  fourth  menu.  Then 

another row with four menus will appear.

The example above (cf. Figure  66) can be read as follows: “Show all  actors whose 

attribute ‘Gender’ contains attribute values that are equal ‘Female’”.

If multiple conditions should be used, then these can be logically combined in the fourth  

menu. “AND” means that both conditions must apply, whereas “OR” means at least one 
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Figure 66: Dialog for editing the attribute filter

Figure 67: Attribute filter with multiple conditions



must apply for the actor to be shown. 

The second example shown in Figure 67 contains two rows and one condition is defined 

in each. Both conditions are connected using “AND”.  The attribute filter, formulated in 

words, says: “Show all actors who are female and younger than 35.”

The second row is special because a non-categorical attribute is used. Therefore, the 

age can be entered manually in the third field. 

The  two  conditions  end  when  no  logical  operator  is  selected  in  the  fourth  menu. 

However, if a logical operator is set, then a third row automatically appears.  

Clicking “OK” closes the window and the digital network map shows all actors who fulfill 

the filter conditions and their relations to other actors who also fulfill the conditions. 

The  attribute  filter  can  be  deactivated  via  “Filter”  >  “Deactivate  Filter”  and  can  be 

reactivated via “Filter” > “Activate Filter”. The filter settings can be changed via “Filter” > 

“Set New Filter”.

When you have activated a filter and then clone the digital network map, only the actors 

and relations that fulfill the filter conditions will be cloned. If you would like to clone all 

actors and relations, then deactivate the filter before cloning.

3.6.2 Relation Filter

The relation filter shows all direct relations of an actor to other actors and hides all other  

relations that are not directly connected to the actor selected (see Figure  68,  69 and 

70).
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A relation filter is activated by right-clicking on the desired actor and then activating 

“Relation Filter”. You can set a relation filter for every actor individually. The relation filter  

only applies to what is displayed; calculations are disregarded. A relation filter can be 

deactivated by right-clicking the actor and selecting “Relation Filter” again.
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Figure 68: Network without relation filter

Figure 70: Network with relation filter

Figure 69: Activating the relation filter for actor  
„B“



3.7 Audio

3.7.1 Starting an Audio Recording

Using VennMaker you can also record interviews with a microphone. Start a recording 

via Analyse > Start Recording.

After a recording has been started, the appearance and labels of the buttons changes:

End a recording by clicking “End Recording”.

Important: before starting a recording, please make sure that the audio settings of your 

operating system are set appropriately!
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Figure 72: The stop button

Figure 71: Audio recording button



3.7.2 Exporting Audio Files

You can export recorded audio files from your interview. Click on “File” > “Audio”.

The following window will open:

VennMaker exports all audio files to the target directory. The audio files are saved in 

wav format and can be opened by most common audio program (e.g. f43).

If you click on “File” > “Audio” and do not yet have any audio files in your interview, 

VennMaker will point this out to you.

3  F4 is a program for audio transcription. It can be downloaded free of charge at the following website: 
http://www.audiotranskription.de/english
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Figure 73: Audio export button

Figure 74: Audio export dialogue



3.8 Network Player

VennMaker tracks all actions that take place on the digital network map. For example, if  

an actor is moved or a new relation drawn, then these activities can be re-played at a 

later date. The network player is used for this.

Open the network player via “Analyse” > “Play” (see Figure 75).

VennMaker then calculates all  individual images, which depending on the number of 

actions can take some time. Then the network player window opens:
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Figure 75: Network player button



The network player  contains three control  buttons “Play”,  “Stop”,  “Slideshow”  and a 

scroll bar. Below the control buttons you will find the time specification of your current 

position within the actions and in parenthesis the total time of the survey. Below the 

scroll bar is a picture of the digital network map. Moving the scroll bar allows you to 

move between the individual actions and you will see the respective illustration of the 

digital network map.

Pressing “Play” causes all actions to run in real time and the respective network maps 

to be shown. Pressing “Slideshow” shows all actions using the same interval. Stop the 

play back by clicking the “Stop” button. 

The network player plays all available audio recording simultaneously with the actions. 

You can start an audio recording via “Analyse” > “Start recoding”. VennMaker will then 

record until you click “Analyse” > “Stop recording”. 
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Figure 76: The network player



Before you start recording, please check whether the audio mixer settings of your operating system are 

properly set and whether the speech quality when using an internal microphone (which is integrated into  

most laptops now) is satisfactory. You may need to use an external microphone.

Important: Audio files are saved in uncompressed form, i.e. the files can be large (100-

400 MB), especially with long interviews. Make sure there is enough free disk space! 

For later versions of VennMaker, we hope to be able to offer the option of compressed 

audio files.

3.9  Compute: Carrying Out Initial Calculations

Calculating  individual  frequency  and  density  for  a  network  can  be  carried  out  via 

“Analyse” > “Calculate”, the results are presented in a separate window (see Figure 77).

The results always pertain to only the active network map. 

The frequency shown contains the number of actors per concentric circle and sector as 

well as the total number of actors drawn on the map (without ego).
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Figure 77: The compute dialogue



The “Density” of the network map indicates the ratio of relations present to the possible 

number of relations.  The density can have a value between 0 and 1. 0 means that there 

are no relations between the actors. If, however, all actors are fully connected with each 

other, the density of the network is 1. The density is a measurement that applies to the  

whole network. 

VennMaker differentiates between density with ego and density where ego is not part of 

the calculation. In the first case, ego is included in the calculations, in the second, only 

relations between others are considered.  The density that includes ego tends to be 

higher  because  the  subject  only  names  people  that  he/she  knows  and  has  less 

knowledge of alter-alter relations. A more precise explanation of the structural measures 

used can be found in chapter 6.1.2

The results can be saved as a CSV file using the button “Export” or, using copy and 

paste, can be copied into other applications.

Using the “Spring Embedder” button you can create a new digital network map which 

arranges actors  using  a  spring  embedder  layout  logarithm.  Here,  actors  with  many 

relations  running  both  to  and  from  them are  displayed  closer  to  the  center  of  the 

network map and actors with fewer relations are displayed closer to the outside. With  

this function, you can see which actors are more isolated and whether, for example, 

there are groups within the network that are more strongly connected to each other.
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Figure 78: The network drawn by the interviewee
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Figure 79: The network after using the spring embedder layout algorithm



3.10  Drucken

To print the current network map, go to “File” and press the “Print” button: 

In the print dialog you can choose the paper size and the paper orientation: 
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If you press the “OK” button you can select the printer and the number of copies. 

Click “Print” and the printing will start. 
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3.11  Interview Notes

Every interview can be tagged with notes. If  you wish to save theoretical  concepts, 

references or interview instructions in addition to your digital network map, you can do 

so via “File” > “Interview Notes”.

3.12 Pseudonymisation

In  order  to  ensure  privacy,  VennMaker  allows  you  to  protect  actor  names  with  a 

password. You can open this window via “File” > “Pseudonymisation “:

In addition to general information on privacy protection and good scientific practice, the 

window contains two input fields. There either you or your interview partner can enter 

the same password twice. Entering the password twice ensures that the password was 
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Figure 80: The password protection dialog



typed correctly. If one entry was inaccurate, VennMaker will prompt you and you can 

correct the password.

This encryption is carried out after the “Encrypt” button has been clicked. Then all actor 

names in the digital network map for the interview are encoded and will be represented 

by numbers on the map. 

You can remove the password protection by following “File” > “Pseudonymisation“ and 

then  entering  the  password.  You  can  start  the  decryption  process  by  clicking  the 

“Decrypt” button. All actor names will then appear on the map. If you enter the wrong 

password, VennMaker will prompt you. 

Privacy Protection and Informed Consent

Data  collected  via  social  network  analysis  are  often  sensitive  personal  data.  VennMaker  allows  the 

collection of official and unofficial network data from persons and institutional actors; this often occurs in  

situations where there is an uneven balance of power and resources. As with other high-capacity tools, 

VennMaker can be used for both legal and illegal purposes. The creators are aware of this problem and 

see  the  security  and  protection  of  personal  data  as  an  important  development  aim.  As  a  license 

holder/user of VennMaker, you are liable – however VennMaker is used – to comply with the regulations 

for safeguarding good scientific practice (cf. e.g. [Universität Trier, 2002]) and in particular to obtain the  

informed consent of subjects (cf. [Bortu and Döring 2006], p. 44).
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4 Configure and Performing an Interview 

Due to  comparative  reasons  a  standardization  of  the  interview framework  is  of  an 

advantage. First, interviews can be configured in advance. Second, performance of an 

interview can be optimized according to test hypothesis using focused questionnaires. 

Moreover, wizards will support an autonomous but guided interview mode. 

4.1 Configure an Interview 

VennMaker offers the “Configure Interview” mode, which will  help to select the item, 

type, order and time sequence of organizing an interview. 

The  “Configure  Interview”-screen  (Figure  81)  is  programmed  to  optimize  the 

performance of  the  designated interviews.  In  order  to  meet  the  need of  a  required 

research design, there are certain ways for adjustment. Starting with entering items for 

Ego, then the Alter name generators and the name interpreters can be described and 

the time sequence can be specified. 
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Figure 81: Main options to configure interviews 



Finally, the design of the questionnaire can be customized using the common options 

screen. 

In Figure 81 you can seee the „Configure Interview“ dialog. The four main sections are 

based on these questions, represented by the tabs: “Ego”, “Name Generator”, “Name 

Interpreter” and “Time Sequence” (see Figure 81).

4.1.1 Configuring Items of Ego 

Figure 82 shows the options to configure the items of Ego, such as location, symbols 

and attributes. Set “Ego is moveable” and the usually center fixed Ego can be placed on  

the  VennMaker-screen  freely.  “Disable  Ego”  leads  to  the  remove  of  Ego  on  the 

VennMaker-  screen.  Even the “Size of  ego is  changeable”  to  resize Ego during an 

interview. Within the “Ego's attribute”, “New” items can be configured using “Edit” and 

existing items can be erased with the function “Delete”. 
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Figure 82: Data entry to select attributes and items of Ego 



Choosing “New” leads to a data entry screen (see Figure  83) to configure the items. 

Insert the name of the item into the “Name of attribute”-field. Formulate the interview 

question using the field extensions of “Related question”-field . Select given answer 

types regarding the “Answer type” part of the screen. “Predefined Answers” helps you to 

prepare  categories  of  supporting  questions.  “New...”  creates  new  answers,  “Edit...” 

corrects predefined answers, and “Delete” removes existing answers from the list.  If 

your test person shall not choose from predefined categories but answer freely instead, 

you can select “allow free answers”. If your test person shall not choose from predefined 

categories but answer freely instead, you can select “allow free answers”. 

Afterwards you can choose between “text” and “numerical”. “Text” permits to enter any 

characters  while  “numerical”  permits  to  enter  numbers  only.  Furthermore,  you  can 

determine  the  type  of  numbers  (“Units”  as  meters,  pounds,  dollars  or  number  of 

persons). Via “minimal value” or “maximal value”, you can restrict the range of numbers. 
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Figure 83: Data entry to configure items of Ego 



You can determine two kinds of answer denial via the options “allow ‘no answer’” and 

“allow ‘don’t know’”. 

The time position for asking a question in the interview is determined via the drop-down 

menu “ask on”: 

“Start of interview”: The question is posed at the beginning of the interview before the 

digital network map will be drawn. 

“Adding to network”: The Question is posed as soon as the Ego is shown on the digital 

network map. 

”End  of  interview”:  The  question  is  posed  after  network  drawing  at  the  end  of  the 

interview. 

The setting will be assumed by clicking on “OK”. The question will be displayed in the 

“Ego’s attributes” list. You can edit the question via “edit”. 
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4.1.2 Configure the Name Generator 

If you choose the tab “name generator”, the input mask for the name generator will be 

opened by itself (see Figure 84).

The primary function of the name generator is to frame the social network. You can 

define further questions for all persons (alteri) surveyed with the name generator via 

“name interpreter” (see Chapter 4.1.3). 

“Max. number of alteri”  specifies the maximum amount of Alteri  the test person can 

enter. “0” signifies no restrictions. The test person can enter Alteri as many as she or he 

likes in the name generator list. 
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Figure 84: Input fields for the name generator 



4.1.3 Configure the Name Interpreter 

The tab “Name Interpreter” opens an input mask in which you can enter, edit and delete 

name interpretators (see Figure 85).

Name interpretators are questions about the characteristics of alteri that were compiled 

using the name generator. Non-relational and relational attributes can be queried.If you 

would like to define attributes, click the “New” button. A new input mask will open (see 

Figure 86). In the field “Name of Attribute” you can enter any item label you wish.  This 

label is hidden during the interview and merely serves to identify items.

In the input field “Related Question” you can formulate a specific question for this item. 

The subject will see this question during the interview.
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Figure 85: Input fields for determination of different name interpreters 



In the section “Answer Type” it is possible to set the various types of answer for the 

question.  You  can  allow the  subject  to  choose  from a  list  of  pre-defined  response 

categories or to enter his/her answer 86).

New  response  categories  can  be  added  via  “New…”,  “Edit…”allows  response 

categories to be edited and “Delete” deletes response categories from the response 

category list. 

By  choosing  “Allow  Multiple  Selections”  the  subject  will  be  able  to  select  multiple 

response categories during the interview. If this option is not selected, then only one 

response category can be chosen. 

Using  “Attribute  Visualization”,  response  categories  can  be  represented  by  visual 

elements:
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Figure 86: Input fields for Alter attributes 



The  subject  selects  the  appropriate  response  category.  VennMaker  then  links  the 

response category with its visual element. If, for example, a question about alteri’s sex 

is asked, then depending on the answer the appropriate symbol will be assigned to this 

person. When the subject then draws his/her network, the other person will  already 

have the appropriate symbol for their sex.

In this  way,  response categories can be linked not  only  to  symbol  type but  also to 

symbol size. Relation lines, sectors and concentric circles can also be linked to pre-

defined answers. The respective menu items under “Attribute Visualization” are “Actor 

Type”, “Actor Size”, “Relation Type”, “Sector” and “Circle”.

Pre-defined answers can be linked to different actor symbols using “Actor Type”. “Edit” 

enables you to change the actor type: select the appropriate response category and 

then click “Edit”. A window with a selection menu will open. Select the desired symbol 

and then click “OK”.  The file name for the symbol in the actor symbol  list  has now 

changed.

The image files for attribute symbols have svg format (svg= scalable vector graphics). If you wish to  

create  your  own  symbols,  simply  use  a  graphic  program  that  supports  svg.  (You  can  find  further  

information on free native svg editors at:  http://www.svgi.org/). Save svg files in the “icons” subfolder in 

VennMaker. Only then will the new image files also appear on the list. 

“Actor Size” allows individual response categories to be linked to different symbol sizes. 

You can also define these sizes (in pixels)  in the list  under “Attribute Visualization”. 

Every line in the size list is linked to the respective response category in the field on the 

left.

“Relation Type”: When an item measures a relational attribute, then this menu item can 

be used to link pre-defined response categories with different line styles. These lines 

are then displayed in the list under “Attribute Visualization”. Use “Edit” to change the line 

styles.
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“Sector”:  individual  sectors  of  the  digital  network  map  can  be  linked  to  response 

categories using this menu item. The answers are assigned clockwise to the sector.  

During  an  interview,  the  subject  will  see  the  respective  pre-defined  answer  in  the 

corresponding sector.

“Circle”:  individual  concentric  circles  in  the  digital  network  map  can  be  linked  to 

response categories using this  menu item. The subject  will  see the respective pre-

defined answer in the corresponding concentric circle on the digital network map. The 

answers are assigned to circles starting at the center and moving out. 

Surveying  using  pre-defined answers  can be done in  various ways in  the  question 

window.  

When you, for example, activate “Matrix”, then the subject will see a table during the 

interview (see Figure  87).
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Figure 87: Input matrix in the Interview mode 



In the first column all Alteri and in the first row the given answers are listed. In the other 

cells there are small clickable boxes. If the proband clicks one of these boxes, he or she 

chooses the respective answer category for the respective Alter. The advantage of this 

kind of questioning is that the proband can see all Alteri with the response spectrum and 

is able to select the answer category quickly. 

Another  design  of  the  interrogative  dialogue  uses  so-called  "Buckets".  Here,  the 

interviewee can pull the Alteri in Buckets / fields (see Figure 88).

Each  bucket  represents  one  given  answer  category.  If  you  have  chosen  "Visual 

Mapping"> "Actor Size", then buckets are used in the interrogative dialog. 

If  you  like  to  get  the  question  answered  independently  –  meaning,  without 

predetermined categories – then activate "Allow free answers". Here, one can choose 

between "text" and "numerical". 
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Figure 88: Buckets in the Interview mode 



"Text" permits the input of any character, while "numerical" permits only numerics. "Unit" 

predefines the unit (for example, dollar, and liter) and "Maximal value" and "Minimal 

value" predefine the upper limit and lower limit of the numeric. 

Via "Allow No answer"“ and "Allow Don't know"“ the proband can refuse the answer and 

give the reason of this refusal at the same time. 
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4.1.4 Setting the Time Sequence of the Interview 

If you choose the tab "Time Sequence", the following template will open: 

In the left section the respective actions are listed following chronological order. The 

order can be changed, while clicking the respective entry and afterwards clicking on 

"Up"  or  "Down".  "Up"  will  shift  the  entry  one  row  upward.  This  means,  that  the 

respective  action  in  the  interview  takes  place  earlier.  "Down"  will  shift  the  entry 

downward, the action takes places chronologically later. 

“New Text Wizard” will create a new text wizard. A text wizard is a simple text window 

which  the  interviewee  can  see  during  the  interview.  It  is  used  to  create  additional  

information and offers help and guidance for the proband, e.g. giving instructions. At the 
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Figure 89: Time Sequence Template 



beginning of the interview, for example, a text wizard “Welcome to the interview!” could 

appear or at the end of the interview one can read “Thanks a lot! Please, click on 'next'  

to stop the interview”. 

4.1.5 Loading and Saving of the Interview Configuration 

You  can  load  an  existing  interview  in  the  configuration  menu  by  choosing  “Load". 

Interview-configuration files will  have the file  extension "vennEn".  You can save the 

settings which you have determined in  the interview configuration menu by clicking 

“Save". 

Via “Start Interview” you can switch over to the interview mode and test your settings. 

“Exit” will finish the configuration mode. The following chapter explains how to conduct a 

preconfigured interview in the “Perform Interview” mode. 
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4.2 Conduction an Interview 

You can conduct a preconfigured interview by choosing the mode “Perform interview”. 

After clicking the button (see Figure  4) you are requested to select a preconfigured 

interview file. Interview files will have the ending “vennEn”. 

Depending on the configuration of the interview the respective interrogative dialogues 

(see Figure  90) will appear. 

By clicking "Next" and “Previous” you are able to navigate between the dialogues -pre 

and -back. If you change to the digital network map you will see a “Next” button on the 

left side with the respective question. 
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Figure 90: Illustration of the name generator dialogue in the Interview mode 



At the end VennMaker stores the interview result in a file in the VennMaker directory. 

The file name consists of a random, six-digit number with the file ending “venn”. You can 

load this file in the “Free Network Drawing” mode for further analyses as well as for  

exporting. 

How to  export  conducted  networks  with  VennMaker  you  will  learn  in  the  following 

chapter. 
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5 Importing Data

If you wish to import to VennMaker a list of actors from another source, you can do so 

via “Data” > “Actors”:
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There you can type the actor names directly into the text box or use copy & paste. 

Every line is a different actor.

If you want to set attribute values for the actors to be imported, you can do so using the 

list of attributes and attribute values below the input field (cf. Figure 91). VennMaker will 

then add the actors to the “Available Actors” list. Then you can add these actors to the 

digital network map and draw the relations between them.
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6 Export of Data 

The following chapters give an outline how to anonymize and export collected data with 

VennMaker.  The chapters imply that  you already have recorded a network.  How to 

record a network and to conduct interviews, is shown in chapter 3 and Kapitel 4.

6.1 Export of digital Network Maps 

VennMaker offers the possibility to safe digital network maps as picture files as well as  

CSV files. 

6.1.1 Saving Digital Network Maps as Image Files

Start VennMaker either in the “Free Drawing” or “Perform Interview” mode. In these 

modes you can save the selected digital network maps via “File” > “Image” as “png” or 

“jpg” files.

How you can save your network data in VennMaker so that you can work with it using 

other programs – such as OpenOffice calc, Excel or SPSS – is explained in the next  

chapter.

6.1.2 Saving Digital Network Maps as CSV Files

VennMaker allows you to save in CSV format (CSV = “Comma Separated Values”) so 

that you can process and further work with your network data.

This is done via “File” > “Actor Data”. You can also select a name under which the files 

should be saved.

In Figure 97 you see the input window for exporting. In the field “Name” you can enter a  

name that all csv files generated will have in their file name. In the “Directory” field you 

see  the  current  export  directory.  You  can  select  a  new  location  using  “Change 

Directory”. Using “Default”, you can return to the default export directory.
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In the section “Export Format” you can set which format the data in the CSV file will be 

saved as. In the English language, for example, decimal points are used instead of 

decimal commas.

To export your digital network map click “Start Export”. All digital network maps for that 

interview will be exported. 
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For every network map at least seven CSV files are generated, whose file names begin  

as follows:

Label Meaning
EGO Contains data on ego
ALTER Contains data on alteri
COMPUTE Network measured values
ADJACENCY Adjacency matrix
ADJACENCY_ALTERI Adjacency matrix without ego
RELATIONGROUPS Contains the number of relation groups that exist between pairs 

of actors
MULTIPLEXITY Contains the number of relation lines that exist between pairs of 

actors
OVERVIEW Interview notes and all attributes, attribute values and the 

attribute value coding

The full name of the ego file is then “EGO_Name.csv”.  Name is a placeholder for the 

name you entered into the “Name” field in the export window. The ego file contains for 

every  network  map the  respective  attributes  and attribute  values  of  ego  and some 

network measurements which will be explained in this chapter.

Encoding and Interview Notes: The file OVERVIEW_Name.txt contains the interview 

notes and all non-relational and relational attributes. In addition to the questions and 

descriptions, the attribute values with their respective numerical codes are also saved. 

This encoding is  automatically  generated by VennMaker and done according to  the 

order of the attribute value entries.

 The Alter file “ALTER_Name.csv” contains information on the alteri: the actors’ names, 

the x and y coordinates, the attribute values and several network parameters. The first 

column contains the unique alteri ID, which is composed using the actor’s name and a 

number. The second column contains the ego ID so that the alteri can be attributed to 

an ego. 

Overall  Network  Parameter  File:  Information  about  the  network  map such  as  the 

density  or  number  of  alteri  is  saved  in  the  file 

“Compute_Name_Networkmapnumber.csv”.
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The  relation  group  file “RELATIONGROUPS_Name_Networkmapnumber.csv” 

contains in addition to the name also a number in the file name. This number refers to 

which network map the file belongs to. 1 is the first network map, 2 the second, etc.

The file contains a matrix with the number of different relation groups between each two 

actors. The data are shown as a matrix. The first column and the first row contain the 

actor IDs. The direction of the relation runs from the actor in the row to the actor in the  

respective  column.  Not  only  are  the  relations  considered,  but  also  the  respective 

relation  groups.  If,  for  example,  two  relations  exist  between  the  actors  (“money 

borrowed” and “emotional importance”) and if these relations belong to different relation 

groups (e.g. “Support (money)” and “Support (emotional aid)”), then a 2 will be entered 

in the matrix. If there is no relation between the actors, then a 0 will be entered in the  

matrix.

The adjacency matrix is saved in the adjacency matrix file “ADJACENCY_Name.csv”. 

Existing relations receive a 1; non-existent relations a 0. Ego is also contained in this  

matrix.

The  adjacency  matrix  is  saved  without  ego  in  the  adjacency  matrix  file 

“ADJACENCY_ALTERI_Name_Networkmapnumber.csv”.

Name: is the name you entered in the export window.

The following three figures show how VennMaker converts the graph in Figure 93 into 

two different matrixes.
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The digital network map in Figure 93 can be read as follows: Ego is in the middle. The 

concentric circles in this example represent the spatial proximity of the alteri to ego. The 

closer the alter to ego on the network map, the closer the alter lives to ego. The actors 

are differentiated using “Gender” and “Role”.  The colored lines visualize the relation 

types between ego and alteri and between the alteri. On the one hand, the frequency of 

contact is shown and on the other, one type of support (emotional support). 

An example: the male actor A lives in the same apartment as ego. There is a strong 

contacting relationship between actor B and ego. Actor B is a friend to ego. Between 

ego and the family member actor E, who lives in another country, there is little contact 

and little emotional support.

Table 1 shows the relation matrix that was saved in the file RELATIONGROUPS_*.csv. 

The matrix contains the same number of rows and columns. The first row and the first 
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column contain the actor IDs. In the first cell of the first column and row is the name of  

the digital network map, in our example this is “Network Map”. The matrix can be read 

as follows: actor G has a relation with actor F. EGO has relations with actor E from two 

different relation groups. The direction of the relation always runs from the row to the 

respective column. As we have an undirected graph – which means the relations run in 

both directions – the matrix is symmetrical,  which means that the section above the 

matrix diagonal running from the top left to the bottom right mirrors the section below 

the matrix diagonal (cf. [Jansen 2006], p 100). In our example, the cell “Actor B – Actor 

C” contains the same value as the cell “Actor C – Actor B”, which is 0. 

Relations that were not drawn are given the value 0 in the matrix. After each name there 

is a unique number which ensures that actors with the same name are distinguishable 

from each other.

Network Map EGO_0 A_1 B_2 C_3 D_4 E_5 F_6 G_7
EGO_0 0 1 1 1 1 2 2 2
A_1 1 0 0 0 0 0 0 0
B_2 1 0 0 0 0 0 0 1
C_3 1 0 0 0 0 0 0 0
D_4 1 0 0 0 0 0 0 0
E_5 2 0 0 0 0 0 0 0
F_6 2 0 0 0 0 0 0 1
G_7 2 0 1 0 0 0 1 0

Table 1: Relation groups as a matrix

In  table  2,  the  adjacency  matrix  (with  ego)  can  be  seen  as  it  is  saved  in 

ADJACENCY.csv. An adjacency matrix is a matrix with the same number of columns 

and rows where existing relations are given a value of 1 and non-existent relation a 

value of 0. 

Network Map EGO_0 A_1 B_2 C_3 D_4 E_5 F_6 G_7
EGO_0 0 1 1 1 1 1 1 1
A_1 1 0 0 0 0 0 0 0
B_2 1 0 0 0 0 0 0 1
C_3 1 0 0 0 0 0 0 0
D_4 1 0 0 0 0 0 0 0
E_5 1 0 0 0 0 0 0 0
F_6 1 0 0 0 0 0 0 1
G_7 1 0 1 0 0 0 1 0

Table 2: Adjacency matrix of ego
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Actor C (5th row) only has a relation with one person, namely with ego (column 2), while 

ego (1st column, 2nd row) has a relation with all other actors. Actor relations with oneself 

are not valued; therefore the matrix diagonal running from the top left to the bottom right  

is valued at 0. 

The Compute.csv file is arranged as follows:
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Netzwerkkarte 7 0 0 1 3 1 2 7 0,321429 0,095238

Table 3: Example of Compute.csv file

The first column represents the name of the network map, in our example “Network 

Map”. The following columns contain the total number of alteri, how many alteri are in 

the  sectors  or  circles,  and  the  density  of  the  network  (with  and  without  ego).  The 

columns which  contain  “Circle”  show the  frequency  of  actors  per  concentric  circle. 

“Circle_1” represents the section outside the concentric circles.

The columns which contain “Sector” show the frequency of actors per sector. “Sector_-

1”  represents the area outside the sectors or,  when no sectors are present,  it  then 

contains the number of alteri.

VennMaker  provides  not  only  the  frequency  calculations  mentioned  here,  but  also 

further  network  analysis  measurements:  density,  degree,  in-degree,  in-degree 

(standardized), out-degree, out-degree (standardized), in-closeness, out-closeness and 

proximity prestige.

Density: the density specifies the degree of connectivity in the network. The network 

density  is  defined by the  number  of  existing relations  divided by  the number of  all  

possible relations (cf. [Jansen 2006], p. 94). VennMaker uses the lines drawn as the 

relations. The network density figure which factors in ego and his/her relations is in the  

column “Density (with ego)” (Table  3), while the density value in the column “Density 

(without ego)” only factors in the alteri and their relations. Which value is important for 
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you depends on your research question (cf. [McCarty and Wutich 2005]).

The OVERVIEW.txt file contains all questions, descriptions and attributes with an exact  

listing of pre-configured attribute values in addition to the interview notes:

Interview notes and list of attributes, values and codes 
============================================= 

Notes: 
--------------------------------------------- 
List of attributes, values and codes: 
--------------------------------------------- 
Actor 

Label: Importance 
Question: 
Describtion: 
Code and Value: 
  1: less important 
  2: not important 
  3: middle 
  4: important 
  5: more important 
  6: most important 
   :missing 
--------------- 
Actor 

Label: Gender
Question: 
Describtion: 
Code and Value: 
  1: Male 
  2: Female 
   :missing

…

Every attribute value of every categorical attribute is automatically tagged with a code. 

For example: the actor attribute “Sex” has the attribute values “Male” and “Female”. 

“Male” is coded as “1” and “Female” is coded as “2”, missing values are represented 

with a missing code.

In Table  4 and Table  5, the attributes of ego and alteri from the example network are 

shown. The degree values contained in the table can be interpreted as follows: the 

degree  of  an  actor  reveals  information  on  how  highly  he/she  is  integrated  into  a 

network. If, for example, a direct relation exists between ego and two actors, then ego 

has a degree of 2.
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In-degree  and  out-degree:  in-degree  and  out-degree  are  simple  measurements  of 

prestige, popularity and social support (cf. [Jansen 2006], p. 96). In-degree expresses 

the  number  of  direct  relations  leading  to  the  actor,  while  out-degree  measures  the 

number of direct relations leading from the actor. VennMaker uses the lines drawn on 

the  network  map  as  the  relations.  Please  note  that  the  in-degree  and  out-degree 

calculations  can  only  take  directed  relations  into  account.  If  you  use  undirected 

relations, the values for in-degree and out-degree will  be the same and refer to the 

degree.

The  values  are  also  standardized  so  that  the  in-degree  and  out-degree  values  in 

different  networks  can be compared.  Standardizing  means that  the  total  number  of 

nodes in the network is taken into account. The standardized degree value (or relative 

degree value) will have a value between 0 and 1. 0 is a low degree value; the actor is  

not linked to any other actor, and a degree value of 1 means that the actor is directly 

linked to all other actors.
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EGO_0 0 0 3 2 54 7 7 0 7 1 1 0 1

Table 4: Ego attributes
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Closeness  (In-closeness  and  Out-closeness):  Is  a  proximity-based  centrality 

measurement. Proximity-based means in this case that the lengths of the relation lines 

for all actors linked directly or indirectly to a particular actor are used in the calculations.  

All actors not linked are left out of the closeness calculation (cf. [Wasserman and Faust 

1994]), p. 184f.). 

When using directed relations, in-closeness measures the relations leading to an actor 

and out-closeness those leading from an actor. 

Proximity Prestige: this calculates how close an actor is to the other actors in his/her 

area of influence. Here closeness is defined solely using the actor’s distance to other 

actors  in  his/her  area of  influence.  If  all  actors  are  adjacent  to  this  actor,  then the 

proximity prestige has a value of 1. If the actor is not linked to any other actor, then the 

proximity prestige value is 0 (cf. [Wasserman and Faust 1994], p.203f.).

How you can further use exported data is explained in the following chapters.
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6.1.3 Import of Data into OpenOffice Calc or Microsoft Excel 

Figure 94: From the digital network map to a diagram

After starting OpenOffice Calc or Excel you can load the respective CSV-file via „New“ > 

„Open“ or you can open the file via double-click. 

In  OpenOffice  Calc  you  will  be  asked  to  set  a  separator.  Here,  you  shall  choose 

„Semicolon“ and then click on „OK“. 

6.1.4 Import of Data into SPSS 

In this subchapter you will learn how to load a CSV file. After starting SPSS (version 15 

or greater) you click on “File” > “Open”. Here, you change to the folder in which you 

have saved the CSV file. After that you choose as data-file “All files (*.*)”. Select the file  

CSV fuile you want to import. 

After that SPSS is starting the Import text wizard: 

In step 1 you handle everything like it is set and only click on “Next”. 

In step 2 please set the question “How are your variables arranged?“ to “Delimited” and 

for “Are variable names included at the top of your file?” click “Yes” and then choose 

“Next”. 
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In the step 3 you shall clarify that the first case is located in the second line, that “Each 

line represents a case” and “All of the cases” shall be imported. After that please click 

on “Next”. 

In  step  4  you  set  the  question  “Which  delimiters  appear  between  variables?”  to 

“Semicolon”.  Please  deactivate  “Space”  and  activate  “None”  in  “What  is  the  text 

qualifier?”. In the data preview field of SPSS all data shall be presented correctly. 

In step 5 you can set the specification for the variables. Therefore, please click the 

particular column in the data preview field and choose the respective data format. If you 

have determined all characteristics of variables please click on “Next”. 

In step 6 you will finish the import by clicking the button “Finish”. 

SPSS is now loading the data; if necessary you have to determine afterwards, if the 

respective variable is “numeric”  by type. This is possible in the variable view in the 

column „Type“. 

6.1.5 Import of Data into Ucinet 

Please start Ucinet (Version 6) and click the button “Matrix spreadsheet”. In the opened 

window click  on  “File”  >”Open”  and  go  to  the  particular  folder,  in  which  you  have 

exported the digital network map with VennMaker as CSV files. Afterwards you shall 

choose the file type “CSV files”. 

Usually all CSV files are listed. Here, choose the respective adjacency file and click on 

“OK”. Subsequently please make sure that the number of rows and columns is equal in 

“Dimensions”.  Finally,  please  safe  the  data  via  “File”  >  “Save  as”  as  “UCINET 4-6 

dataset”. 
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6.1.6 Visualization of Network Graphs with NetDraw 

In the next step please start NetDraw (Version 2.0) and load saved dataset-files: 

“File” > “Open” > “Ucinet dataset” > “Network” 

The following options have to be selected: 

File format: Ucinet (*.##h) 

Type of data: 1-Mode Network(s) 

Ignore reflexive ties: should be activated 

Ties have values > 0.0 

Please choose the file which you have saved in Ucinet via “...” and click “OK“. Now the  

network will be drawn and further calculations can be carried out. 

120



Copyright Informationen

VennMaker-Lizenz

Copyright  © 2007-2008 Michael  Schoenhuth,  Mathias Pohl,  Markus Gamper,  Martin 

Stark

Copyright © 2009 Michael Schoenhuth, Markus Gamper, Martin Stark

Copyright © 2010-2011 Michael Schoenhuth, Markus Gamper, Martin Stark,  Michael 

Kronenwett

All rights reserved.

This disclaimer governs your use of the software VennMaker. By using VennMaker, you 

accept this disclaimer in full. If you disagree with any part of this disclaimer, you must 

not use VennMaker. Unless otherwise stated, we or our licensors own the intellectual 

property  rights  in  the  VennMaker  software.  Subject  to  the  license  below,  all  these 

intellectual property rights are reserved.

License

Permission  to  work  with  VennMaker  for  educational  and  research  purposes  only  is 

hereby granted, provided that this copyright notice and the original inventor‘s names 

(Schoenhuth/Gamper/Stark/Kronenwett © 2010) appears on all copies and supporting 

documentation.

For any other uses of this software, in original or modified form, including but not limited 

to distribution in whole or in part, and especially for all forms of commercial use specific 

prior permission must be obtained from the copyright holders.

The software, models and documentation shall not be used, rewritten, or adapted as the 

basis of a commercial software or hardware product without first obtaining appropriate 

licenses from the copyright holders. We make no representations about the suitability of 

this software for any purpose.  It is provided „as is“ without express or implied warranty.
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Data protection and informed consent

VennMaker  allows  to  elicit  official  and  non-official  network  data  of  persons  and 

institutional actors, and this in settings where often unequal power relationships and 

resource distribution prevail. As with any other powerful instrument VennMaker could be 

used for various legal and non-legal purposes. The inventors are aware of this problem 

and make security and protection of personal data a prime development goal.

The user of VennMaker is obliged to use the software only with the informed consent of 

those who share their social networks during this process, according to existing legal 

rules of confidentiality and data protection. Any data produced and stored have to be 

anonymized or encrypted, in a way, that it is not possible to draw tracable personal 

information of any kind by third parties that otherwise could not be drawn from official 

sources.

Limitations of warranties and liability

Whilst we endeavour to ensure that VennMaker is running properly, we do not warrant 

its completeness or accuracy; nor do we commit to ensuring that VennMaker remains 

available or that it is kept up-to-date. 

To the maximum extent  permitted by applicable law we exclude all  representations, 

warranties and conditions relating to VennMaker and the use of it (including, without 

limitation,  any  warranties  implied  by  law  of  satisfactory  quality,  fitness  for  purpose 

and/or the use of reasonable care and skill).

Nothing in this disclaimer will exclude or limit our liability for fraud, for death or personal 

injury caused by our negligence, or for any other liability which cannot be excluded or 

limited under applicable law.

Subject to this, our liability to you in relation to the use of VennMaker or under or in  

connection  with  this  disclaimer,  whether  in  contract,  tort  (including  negligence)  or 

otherwise, will be limited as follows:

(a) to the extent that VennMaker and the information and services are provided free-of-
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charge, we will not be liable for any loss or damage of any nature;

(b) we will not be liable for any consequential, indirect or special loss or damage;

(c) we will  not be liable for any loss of profit,  income, revenue, anticipated savings, 

contracts, business, goodwill, reputation, data, or information.

Revision

We may revise this disclaimer from time-to-time. The revised disclaimer will apply to the 

use of VennMaker from the date of the publication of the revised disclaimer on our  

website http://www.vennmaker.com/. Please check this page regularly to ensure you are 

familiar with the current version.

Part of the text is drawn with permission from: 

http://www.website-law.co.uk/disclaimer.html
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Lizenzen verwendeter Bibliotheken

Xstream

Copyright (c) 2003-2006, Joe Walnes

Copyright (c) 2006-2007, XStream Committers

All rights reserved.

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions are met:

Redistributions  of  source  code  must  retain  the  above  copyright  notice,  this  list  of 

conditions and the following disclaimer. Redistributions in binary form must reproduce 

the above copyright notice, this list  of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.

Neither the name of XStream nor the names of its contributors may be used to endorse 

or promote products derived from this software without specific prior written permission.

THIS  SOFTWARE  IS  PROVIDED  BY  THE  COPYRIGHT  HOLDERS  AND 

CONTRIBUTORS  „AS  IS“  AND  ANY  EXPRESS  OR  IMPLIED  WARRANTIES, 

INCLUDING,  BUT  NOT  LIMITED  TO,  THE  IMPLIED  WARRANTIES  OF 

MERCHANTABILITY  AND  FITNESS  FOR  A  PARTICULAR  PURPOSE  ARE 

DISCLAIMED.  IN  NO  EVENT  SHALL  THE  COPYRIGHT  OWNER  OR 

CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 

EXEMPLARY,  OR CONSEQUENTIAL DAMAGES (INCLUDING,  BUT NOT LIMITED 

TO,  PROCUREMENT OF  SUBSTITUTE  GOODS OR  SERVICES;  LOSS OF  USE, 

DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 

ANY THEORY OF  LIABILITY,  WHETHER  IN  CONTRACT,  STRICT LIABILITY,  OR 

TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 

THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 

DAMAGE.
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Batik SVG Toolkit

Copyright 2009 Batik SVG Toolkit

Licensed under the Apache License, Version 2.0 (the „License“); you may not use this 

file except in compliance with the License. You may obtain a copy of the License at 

http://www.apache.org/licenses/LICENSE-2.0 

Unless required by applicable law or agreed to in writing, software distributed under the 

License  is  distributed  on  an  „AS  IS“  BASIS,  WITHOUT  WARRANTIES  OR 

CONDITIONS OF ANY KIND, either express or implied. See the License for the specific  

language governing permissions and limitations under the License. 

Tango Desktop Project

The color palette is public domain. The icon theme is also available as public domain 

since the 0.8.90 release. While you are not obligated to, we would appreciate if you 

credit the project if you chose to use the icon theme or derivative artwork in your project 

by  linking  to  our  website.  This  will  help  to  strengthen  the  awareness  of  the  style 

guidelines. Thank you. http://tango.freedesktop.org/Tango_Desktop_Project

SwingX

GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007

Copyright © 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, 

but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and 

conditions  of  version  3  of  the  GNU General  Public  License,  supplemented  by  the 
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additional permissions listed below.

0. Additional Definitions.

As used herein, “this License” refers to version 3 of the GNU Lesser General Public 

License, and the “GNU GPL” refers to version 3 of the GNU General Public License.

“The  Library”  refers  to  a  covered  work  governed  by  this  License,  other  than  an 

Application or a Combined Work as defined below.

An “Application” is any work that makes use of an interface provided by the Library, but 

which is not otherwise based on the Library. Defining a subclass of a class defined by 

the Library is deemed a mode of using an interface provided by the Library.

A “Combined Work” is a work produced by combining or linking an Application with the 

Library. The particular version of the Library with which the Combined Work was made 

is also called the “Linked Version”.

The “Minimal Corresponding Source” for a Combined Work means the Corresponding 

Source  for  the  Combined  Work,  excluding  any  source  code  for  portions  of  the 

Combined Work that, considered in isolation, are based on the Application, and not on 

the Linked Version.

The “Corresponding Application Code” for a Combined Work means the object code 

and/or source code for the Application, including any data and utility programs needed 

for reproducing the Combined Work from the Application,  but  excluding the System 

Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being 

bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.
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If  you modify a copy of the Library,  and, in your modifications, a facility  refers to a 

function or data to be supplied by an Application that uses the facility (other than as an 

argument passed when the facility  is invoked),  then you may convey a copy of the 

modified version:

• a) under this License, provided that you make a good faith effort to ensure that, in 

the event an Application does not supply the function or data, the facility  still  

operates, and performs whatever part of its purpose remains meaningful, or 

• b) under the GNU GPL, with none of the additional permissions of this License 

applicable to that copy. 

3. Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that  

is part of the Library. You may convey such object code under terms of your choice, 

provided that, if the incorporated material is not limited to numerical parameters, data 

structure layouts and accessors, or small macros, inline functions and templates (ten or 

fewer lines in length), you do both of the following:

• a) Give prominent notice with each copy of the object code that the Library is 

used in it and that the Library and its use are covered by this License. 

• b) Accompany the object code with a copy of the GNU GPL and this license 

document. 

4. Combined Works.

You may convey a Combined Work under terms of your choice that, taken together, 

effectively do not restrict  modification of the portions of the Library contained in the 

Combined Work and reverse engineering for debugging such modifications, if you also 

do each of the following:

• a) Give prominent notice with each copy of the Combined Work that the Library is 

used in it and that the Library and its use are covered by this License. 
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• b) Accompany the Combined Work with a copy of the GNU GPL and this license 

document. 

• c) For a Combined Work that displays copyright notices during execution, include 

the copyright notice for the Library among these notices, as well as a reference 

directing the user to the copies of the GNU GPL and this license document. 

• d) Do one of the following: 

• 0)  Convey  the  Minimal  Corresponding  Source  under  the  terms of  this 

License, and the Corresponding Application Code in a form suitable for, 

and  under  terms  that  permit,  the  user  to  recombine  or  relink  the 

Application with a modified version of  the Linked Version to produce a 

modified Combined Work, in the manner specified by section 6 of the GNU 

GPL for conveying Corresponding Source. 

• 1) Use a suitable shared library mechanism for linking with the Library. A 

suitable mechanism is one that (a) uses at run time a copy of the Library 

already  present  on  the  user's  computer  system,  and  (b)  will  operate 

properly with a modified version of the Library that is interface-compatible 

with the Linked Version. 

• e) Provide Installation Information, but only if you would otherwise be required to 

provide such information under section 6 of the GNU GPL, and only to the extent  

that such information is necessary to install and execute a modified version of the 

Combined  Work  produced  by  recombining  or  relinking  the  Application  with  a 

modified version of the Linked Version. (If you use option 4d0, the Installation 

Information  must  accompany  the  Minimal  Corresponding  Source  and 

Corresponding Application Code. If  you use option 4d1, you must provide the 

Installation Information in the manner specified by section 6 of the GNU GPL for 

conveying Corresponding Source.) 

5. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a 
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single library together with other library facilities that are not Applications and are not 

covered by  this  License,  and convey such a combined library  under  terms of  your 

choice, if you do both of the following:

• a) Accompany the combined library with a copy of the same work based on the 

Library, uncombined with any other library facilities, conveyed under the terms of 

this License. 

• b) Give prominent notice with the combined library that part of it is a work based 

on the Library, and explaining where to find the accompanying uncombined form 

of the same work. 

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU 

Lesser General Public License from time to time. Such new versions will be similar in 

spirit  to  the  present  version,  but  may  differ  in  detail  to  address  new  problems  or 

concerns.

Each version is given a distinguishing version number. If the Library as you received it 

specifies that a certain numbered version of the GNU Lesser General Public License “or 

any later version” applies to it, you have the option of following the terms and conditions 

either of that published version or of any later version published by the Free Software 

Foundation. If the Library as you received it does not specify a version number of the 

GNU Lesser General Public License, you may choose any version of the GNU Lesser 

General Public License ever published by the Free Software Foundation.

If  the  Library  as  you  received  it  specifies  that  a  proxy  can  decide  whether  future 

versions of  the GNU Lesser  General  Public  License shall  apply,  that  proxy's  public 

statement of acceptance of any version is permanent authorization for you to choose 

that version for the Library.
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